
            CCA-101: Fundamentals of IT & Programming 
Assignment-1 

 
 
Ans 1:- A computer has four main components: Input Units, the central processing unit 
or CPU, the Primary memory, and Output units. Input Unit - The devices to input 
information, such as a keyboard, and mouse. CPU - The CPU is further broken up into 
ALU, Control Unit, and Instruction Unit. 

                                        
 
 
 
 
 

1. Input: This is the process of entering data and programs in to the computer system. 
You should know that computer is an electronic machine like any other machine which 
takes as inputs raw data and performs some processing giving out processed data. 
Therefore, the input unit takes data from us to the computer in an organized manner for 
processing. 

2. Storage: The process of saving data and instructions permanently is known as 
storage. Data has to be fed into the system before the actual processing starts. It is 
because the processing speed of Central Processing Unit (CPU) is so fast that the data 
has to be provided to CPU with the same speed. Therefore the data is first stored in the 
storage unit for faster access and processing. This storage unit or the primary storage 
of the computer system is designed to do the above functionality. It provides space for 
storing data and instructions. 

The storage unit performs the following major functions:  

All data and instructions are stored here before and after processing.  

• Intermediate results of processing are also stored here.  

3. Processing: The task of performing operations like arithmetic and logical operations 
is called processing. The Central Processing Unit (CPU) takes data and instructions 
from the storage unit and makes all sorts of calculations based on the instructions given 
and the type of data provided. It is then sent back to the storage unit.  
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4. Output: This is the process of producing results from the data for getting useful 
information. Similarly the output produced by the computer after processing must also 
be kept somewhere inside the computer before being given to you in human readable 
form. Again the output is also stored inside the computer for further processing.  

5. Control: The manner how instructions are executed and the above operations are 
performed. Controlling of all operations like input, processing and output are performed 
by control unit. It takes care of step by step processing of all operations inside the 
computer. 

Functional Units 

In order to carry out the operations mentioned in the previous section the computer 
allocates the task between its various functional units. The computer system is divided 
into three separate units for its operation. They are  

Arithmetic Logical Unit (ALU)   

Logical Unit :After you enter data through the input device it is stored in the primary 
storage unit. The actual processing of the data and instruction are performed by 
Arithmetic Logical Unit. The major operations performed by the ALU are addition, 
subtraction, multiplication, division, logic and comparison. Data is transferred to ALU 
from storage unit when required. After processing the output is returned back to storage 
unit for further processing or getting stored.  

Control Unit (CU)   

The next component of computer is the Control Unit, which acts like the supervisor 
seeing that things are done in proper fashion. Control Unit is 
responsible  for  coordinating various operations using time signal. The control unit 
determines the sequence in which computer programs and instructions are executed. 
Things like processing of programs stored in the main memory, interpretation of the 
instructions and issuing of signals for other units of the computer to execute them. It 
also acts as a switch board operator when several users access the computer 
simultaneously. Thereby it coordinates the activities of computer‘s peripheral equipment 
as they perform the input and output. 

Central Processing Unit (CPU) 

The ALU and the CU of a computer system are jointly known as the central processing 
unit. You may call CPU as the brain of any computer system. It is just like brain that 
takes all major decisions, makes all sorts of calculations and directs different parts of 
the computer functions by activating and controlling the operations. 

 

Ans 2:- Classification digital Computer based on size and Capability 
              Based on size and capability, computers are broadly classified into 

                        Microcomputers(Personal Computer) 
 A microcomputer is the smallest general purpose processing system. The older pc 
started 8 bit processor with speed of 3.7MB and current pc 64 bit processor with 
speed  of 4.66 GB.  
Examples: -     IBM PCs, APPLE computers 
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Microcomputer can be classified into 2 types : 
1.       Desktops 
2.       Portables 

The difference is portables can be used while travelling whereas desktops computers 
cannot be carried around. 

The different portable computers are: - 
1)         Laptop 
2)         Notebooks 
3)         Palmtop (hand held) 
4)         Wearable computers 

Laptop: - this computer is similar to a desktop computers but the size is smaller. They 
are expensive than desktop. The weight of laptop is around 3 to 5 kg 
 
Notebook: - These computers are as powerful as desktop but size of these computers 
are comparatively smaller than laptop and desktop. They weigh 2 to 3 kg. They are 
more costly than laptop. 
 
Palmtop (Hand held): - They are also called as personal Digital Assistant (PDA). 
These computers are small in size. They can be held in hands. It is capable of doing 
word processing, spreadsheets and hand writing recognition, game playing, faxing and 
paging. These computers are not as powerful as desktop computers 
 
Wearable computer: - The size of this computer is very small so that it can be worn on 
the body. It has smaller processing power. It is used in the field of medicine. For 
example pace maker to correct the heart beats. Insulin meter to find the levels of insulin 
in the blood. 
 
Minicomputer: -  A minicomputer is a medium-sized computer. That is more powerful 
than a microcomputer. These computers are usually designed to serve multiple users 
simultaneously (Parallel Processing). They are more expensive than microcomputers. 

Mainframe computers: - Computers with large storage capacities and very high speed 
of processing (compared to mini- or microcomputers) are known as mainframe 
computers. They support a large number of terminals for simultaneous use by a number 
of users like ATM transactions. They are also used as central host computers in 
distributed data processing system. 

Supercomputer:-   Supercomputers have extremely large storage capacity and 
computing speeds which are many times faster than other computers. A supercomputer 
is measured in terms of tens of millions Instructions per second (mips), an operation is 
made up of numerous instructions. The supercomputer is mainly used for large scale 
numerical problems in scientific and engineering disciplines such as Weather analysis. 

 

Q3: What is the meaning of computer generation? How many Computer 
Generations are defined? What technologies were/are used? 

Ans:- the generation term was used to distinguish between varying hardware 
technologies. Nowadays, generation includes both hardware and software, which 
together make up an entire computer system. There are five computer generations 
known till date. 



First Generation: Vacuum Tubes (1940-1956): 
The first computer systems used vacuum tubes for circuitry and magnetic drums for 
memory, and were often enormous, taking up entire rooms. These computers were very 
expensive to operate and in addition to using a great deal of electricity, the first 
computers generated a lot of heat, which was often the cause of malfunctions. First 
generation computers relied on machine language, the lowest-level programming 
language understood by computers, to perform operations, and they could only solve 
one problem at a time. It would take operators days or even weeks to set-up a new 
problem. Input was based on punched cards and paper tape, and output was displayed 
on printouts. The UNIVAC (Universal Automatic Computer) and ENIAC (Electronic 
Numerical Integrator and Computer) computers are examples of first-generation 
computing devices. The UNIVAC was the first commercial computer delivered to a 
business client, the U.S. Census Bureau in 1951 
 
Second Generation: Transistors (1956-1963): 
The world would see transistors replace vacuum tubes in the second generation of 
computers. The transistor was invented at Bell Labs in 1947 but did not see widespread 
use in computers until the late 1950s. 
The transistor was far superior to the vacuum tube, allowing computers to become 
smaller, faster, cheaper, more energy-efficient and more reliable than their first-
generation predecessors. Though the transistor still generated a great deal of heat that 
subjected the computer to damage, it was a vast improvement over the vacuum tube. 
Second-generation computers still relied on punched cards for input and printouts for 
output. Second-generation computers moved from cryptic binary machine language to 
symbolic, or assembly, language. 
 
Third Generation: Integrated Circuits (1964-1971) 
The development of the integrated circuit was the hallmark of the third generation of 
computers. Transistors were miniaturized and placed on silicon chips, called 
semiconductors, which drastically increased the speed and efficiency of computers. 
Instead of punched cards and printouts, users interacted with third generation 
computers through keyboards and monitors and interfaced with an operating system, 
which allowed the device to run many different applications at one time with a central 
program that monitored the memory. Computers for the first time became accessible to 
a mass audience because they were smaller and cheaper than their predecessors. 
Fourth Generation: Microprocessors (1971-Present): 
The microprocessor brought the fourth generation of computers, as thousands of 
integrated circuits were built onto a single silicon chip. What in the first generation filled 
an entire room could now fit in the palm of the hand. The Intel 4004 chip, developed in 
1971, located all the components of the computer—from the unit and memory to 
input/output controls—on a single chip. In 1981 IBM introduced its first computer for the 
home user, and in 1984 Apple introduced the Macintosh. Microprocessors also moved 
out of the realm of desktop computers and into many areas of life as more and more 
everyday products began to use microprocessors. As these small computers became 
more powerful, they could be linked together to form networks, which eventually led to 
the development of the Internet. Fourth generation computers also saw the 
development of GUIs, the mouse and handheld devices. 
 
Fifth Generation: Artificial Intelligence (Present and Beyond): 
Fifth generation computing devices, based on artificial intelligence, are still in 
development, though there are some applications, such as voice recognition, that are 
being used today. The use of parallel processing and superconductors is helping to 
make artificial intelligence a reality. Quantum computation and molecular and 
nanotechnology will radically change the face of computers in years to come. The goal 



of fifth-generation computing is to develop devices that respond to natural language 
input and are capable of learning and self-organization. 
 
 
Q4: Differentiate between Volatile & Non- Volatile memories. 

Ans:- Volatile Memory: 
It is the memory hardware that fetches/stores data at a high-speed. It is also referred as 
temporary memory. The data within the volatile memory is stored till the system is 
capable of, but once the system is turned off the data within the volatile memory is 
deleted automatically. RAM (Random Access Memory) and Cache Memory are some 
common examples of volatile memory. Here, data fetch/store is fast and economical.  

Non-Volatile Memory: 
It is the type of memory in which data or information is not lost within the memory even 
power is shut-down. ROM (Read Only Memory) is the most common example of non-
volatile memory. It‘s not economical and slow in fetch/store as compared to volatile 
memory however stores higher volume of data. All such information that needs to be 
stored for an extended amount of time is stored in non-volatile memory. Non-volatile 
memory has a huge impact on a system‘s storage capacity. 

Q5: Distinguish among system software, application software and open source 
software on the basis of their features. 

Ans:- System Software: It is a type of software that is designed to run a computer's 

hardware and application programs. Software like operating systems, compilers, editors 
and drivers etc., come under this category. A computer cannot function without the 
presence of these. If we think of the computer system as a layered model, the system 
software is the interface between the hardware and user applications. 
 
Operating System (OS): Operating system acts as manager of all the resources of 
computer, i.e. resource manager. It is system software that manages computer 
hardware and software resources and provides services. Thus operating system becomes 

an interface between user and machine 
 
Utility Programs: These programs analyze and maintain a computer. These programs 
are focused on how OS works on that basis it perform task to enable smooth functioning 
of computer. This program may come along with OS like windows defender, windows 
disk cleanup tool, Antivirus, backup software, files manager, disk compression tool all 
are utility software. 
 
Application software: It is software created for a specific purpose, used by end users. 
It can be called an application or simply an app. Examples: word processor, accounting 
application, a web browser, an email client, media player etc 
 
Proprietary Software: It is software that is owned by an individual or a company 
(generally the one that developed it). There are almost always major restrictions on its 
use, and its source code is almost always kept secret. The proprietary Software is a 
non-free computer software for which 
the software's publisher or another person retains intellectual property rights— 
usually copyright of the source code. It is also known as ‗closed-source software‘. 
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Overview of open source technology: Open source technology is defined as the 
development of software for allowing end users and developers to not only see the 
source code of software, but modify it as well. 
 
Open-source software (OSS) is a type of computer software in which source code is 
released under a license in which the copyright holder grants users the rights to study, 
change, and distribute the software to anyone and for any purpose. The Linux operating 
system(OS) is the best-known examples of open source software technology 
 
Q6. a) Create a file in MS-word to insert a paragraph about yourself and save it 
with file name “yourself”. Describe all steps involved in it. 
 
Ans:- CREATING A NEW DOCUMENT 
 
To create a new document: 
 

 Click the Microsoft Office button / File tab. 

 Selec tNew. The New Document dialog box appears. 

 Select Blank document. It will be highlighted by default. 

 A new blank document appears in the Word window. 

 Now you can create document by inserting text  

 Finally save document 
 
SAVING DOCUMENTS 
To Save document using Save As command: 

 Click the Microsoft Office button/ File tab 

 .Select Save As –Word Document 

 Select the location where you want to save the document using the drop-down 
menu 

 Enter a name yourself  for the document. 

 Click the Save button. 
 
Q6 b) Write steps regarding followings  
 

To change the font style  
 

To change the font size  
 
To change the font color  
 
To highlight (in yellow) the line that reads “need to get IMS‟s address”.  

 
Ans:-To change font style 

 Select the text you want to modify. 

 Click on font style box on the Home tab. The font style drop-down menu appears. 

 Move your cursor over the various font styles.  

 Left-click the font style you want to use. 

 Then font style will change in the document 
 
To change the font size  

 Click on font size box in the Font group on the Home tab. The font size drop-
down menu appears. 

 Move your cursor over the various font sizes. 



 Left-click on font size you want to use.  

 Then it will change font size in your document. 
 
 

To change font color 

 Select the text you want to modify. 

 Click on the font color box on the Home tab. The font color menu appears. 

 Move your cursor over the various font colors.  

 Left-click the font color you want to use.  

 Then font color will change in the document. 
 
 
To highlight (in yellow) the line that reads “need to get IMS‟s address”.  

  Click on the Text Highlight color in font group on the Home tab. 

  Various colors will appears 

  Move your cursor over the various colors. 

  Click on color you want to use. 

  Then text highlight color will change in the document 
 
 
Q7. Create a file in MS-Word for the following document and save it with file name 
„ms_word‟. Describe all steps involved in it. 
 
Ans:- To create a new document: 

 Click the Microsoft Office button / File tab. 

 Select New. The New Document dialog box appears. 

 Select Blank document. It will be highlighted by default. 

 A new blank document appears in the Word window. 

 Now you can create document by inserting text  

 Finally save document 
 

To Save document using Save As command: 

 Click the Microsoft Office button/ File tab. 

 Select Save As –Word Document 

 Select the location where you want to save the document using the drop-down 
menu. 

 Enter a name „ms_word‟ for the document. 

 Click the Save button. 
 
Q8. Create a file in MS-word for the following document and save it with file name 
„equations‟. Describe all steps involved in it. 
 
Ans:- To create a new document: 

 Click the Microsoft Office button / File tab. 

 Select New. The New Document dialog box appears. 

 Select Blank document. It will be highlighted by default. 

 A new blank document appears in the Word window. 

 Now you can create document by inserting text  

 Finally save document 
 

To Save document using Save As command: 

 Click the Microsoft Office button/ File tab. 



 Select Save As –Word Document 

 Select the location where you want to save the document using the drop-down 
menu. 

 Enter a name „equations‟ for the document. 

 Click the Save button. 
 
Q9. Create a file in MS-word that convert existing highlight text to table as shown 
below and save it as file name „text_to_table‟. Describe all steps involved in it. 
 
Ans:- To convert existing text to a table: 

 Select the text you want to convert. 

 Select the Insert tab. 

 Click on Table command. A dialog box appears 

 Click on Convert Text to Table, a new dialog box appears 

 here set number of columns. 

 Click on OK 

 Finally Selected text convert in a table. 
 
Q10. Create a file in MS-Word to insert a table in the document. Describe all steps 
involved in it. 
 
Ans:- To create a new document: 

 Click the Microsoft Office button / File tab. 

 Select New. The New Document dialog box appears. 

 Select Blank document. It will be highlighted by default. 

 A new blank document appears in the Word window. 

 Now you can create document by inserting text  

 Finally save document 
 
To insert a table: 

 Place your insertion point in the document where you want to insert table  

 Select the Insert tab. 

 Click the Table command. 

 Drag your mouse over the diagram squares to select the number of columns and 
rows in the table.  

 Left-click your mouse, and the table appears in the document. 

 Enter text into the table. 
 
Q11. Create a following worksheet in MS-excel and save it with name „book1‟. 
 
Ans:-  

 Left-click the Microsoft Office button. 

 Select New. The New Workbook dialog box opens, and Blank Workbook is 
highlighted by default. 

 Click Create. A new blank workbook appears in the window. 

 When you first open Excel, the software opens to a new blank workbook as 
below. 

 
Q12. Calculate the following things of a range (C2:C11) of data in the worksheet 
created in question no 10.  
 

 the sum of the marks using AutoSum in a range of cells (C2:C11)  
 



 average of the marks in a range of cells (C2:C11)  
 

 highest marks in a range of cells (C2:C11)  
 

 minimum marks in a range of cells (C2:C11)  
 

 
Ans:-  the sum of the marks using AutoSum in a range of cells (C2:C11)  

Type =SUM in a cell, followed by an opening parenthesis (. 

To enter the first formula range, which is called an argument (a piece of data the 
formula needs to run), type A2:A4 (or select cell A2 and drag through cell A6). 

Type a comma (,) to separate the first argument from the next. 

Type the second argument, C2:C3 (or drag to select the cells). 

Type a closing  parenthesis ), and then press Enter. 

 

Q13 a) Describe various steps involved in the following  
 

 To modify column width of a worksheet  
 

 To modify the row height of a worksheet  
 

 To delete rows and columns of a worksheet  
 

Ans:- To modify column width of a worksheet  
 
Position the cursor over the column line in the column heading, and a double 
arrow will appear. 
Left-click the mouse, then drag the cursor to the right to increase the column 
width or to the left to decrease the column width. 
 Release the mouse button. 
 

 To modify the row height of a worksheet  
 Position the cursor over the row line you want to modify, and a double 
arrow will appear. 
Left-click the mouse, then drag the cursor upward to decrease the row height 
or downward to increase the row height. 
Release the mouse button. 
 

 To delete rows and columns of a worksheet  
Select the row or column you‘d like to delete. 
Click the Delete command in the Cells group on the Home tab. 
 
 
 
Q13 b) Describe following terms in the worksheet  

 Absolute reference and relative reference in formula  

 Cell address  



Ans:-- 
.Absolute reference  
Absolute Reference; cell references in a formula always refer to the same cell or cell 
range . If a formula is copied to a different location, the absolute reference remains the 
same.   
 An absolute reference is designated in the formula by the addition of a dollar sign ($). 
It can precede the column reference or the row reference, or both. Examples of 
absolute referencing include: 

 

relative reference 
Cell references in formula automatically adjust to new locations when the formula is 
pasted into different cells. This is called a relative reference. 

 
 
Cell address  
When a cell address is used as part of a formula, this is called a cell reference. It is 
called a cell reference because instead of entering specific numbers into a formula, the 
cell address refers to a specific cell. 
 

Q14. a) What tools are available to customize our PowerPoint presentation? 

Ans:-- Microsoft PowerPoint is an interesting and useful program that is widely used to 
prepare slideshows for Public Seminars and Presentations. 
 
From an Artistic Perspective, individuals cannot easily understand theories alone for 
hours but can obtain much more within minutes or even seconds, with the use of Visual 
Presentations backing Theory. 
 
PowerPoint can solve the Problem in terms of communication technology for everyone. 
There are complicated and sophisticated methods for such; however the simplest and 
most commonly used method which has being used almost everywhere and anywhere 
in the world during Public 
 
Presentations & Seminars was the use of PowerPoint applications for seminars. 
1. Open Microsoft PowerPoint. 



2. Go to File at the top of the screen and click New. 

3. In the ―New Presentation‖ dialog box, click on ―From Design Template.‖ 
(When we start a new presentation PowerPoint, we have the opportunity to choose a 
theme or template. A theme is a slide design that contains matching colors, fonts, and 
special effects etc) 
 
4. Step 4: Do Slide Design.(As per requirement) ... 
5. Step 6: Adding Text. (As per requirement) 
6. Step 7: Adding Pictures. . (As per requirement).. 
7. Save your presentation 
 

Q14 b) Write the steps for the following action for creation of power point 
presentation  

 Open a Blank presentation  

 Save the presentation as Lab1.pptx  

 Add a Title to the first slide: the name of your college  

 Type your first name and last name in the Subtitle section  

 Add a New Slide which has a Title and Content  

Ans:-- Open a Blank presentation: 

Click the Microsoft PowerPoint Button, and then click New. In the New Presentation 
dialog box, do one of the following: Under Templates,double  click Blank presentation. 

Save the presentation as Lab1 .pptx : 

It's a good idea to keep saving our work periodically as we never know when we will 
lose power or when our computer is likely to crash. Keep saving it. At the time of 
creation of new presentation (first time), please save it with the help of following steps:  

1. Locate and select the Save command on the Quick Access Toolbar. 
2. If you're saving the file for the first time, the Save As pane will appear in backstage 
view. 
3. You'll then need to choose where to save the file and give it a file name. 
4. The Save As dialog box will appear. 

Add a Title to the first slide: the name of your college : 

When you start PowerPoint, PowerPoint displays the title slide in the Slide pane. You 
can type the title of your presentation and a subtitle on this slide. To enter text: 

 Click and type the title of your presentation in the "Click to add title" area. Write 
than.Name of college  

Add a New Slide which has a Title and Content  

Once you have selected a slide, click Home > Slides > New Slide. You'll notice that 
the New Slide button is in two halves. If you click the top half of the New Slide button, 
the default Title and Content type slide will be added. 

 



Q15. Write steps for creation of a set of PowerPoint slides that demonstrates your 
skill to use the tools of PowerPoint. It should include the following things  
 

 Title slide &bullet list  

 Inserting Excel Sheet  

 Clip art and Text  

 Slide show effects  
 
 
 Title slide &bullet list  

 Start Microsoft PowerPoint.  

 Open arbitrary existing PowerPoint presentation. 

 Click the New Slide button on the Formatting toolbar.  

 The Slide Layout task pane appears as shown in the above figure. The Slide 
Layout task pane lets you select from numerous layouts that determine what you 
want pear on the new slide. We want to add a Bulleted List Slide. 

Inserting Excel Sheet  
The great thing about the Microsoft Office Suite is the fluid interaction of each 
application type. By embedding the Excel document into your presentation or document 
you can use it to make a point more effectively with numbers or even graphs. 
 

 In PowerPoint, select the Insert tab & Click the Insert tab. 

 Click the Object command in the Text group. ... 

 A dialog box will appear. ... 

 Locate and select the desired Excel file, then click Insert. ... 
 
Clip art and Text  

 Click in the slide where you want to insert a clip art file. 

 On the Insert tab, in the Images group, click Online Pictures. (In PowerPoint 
2007/2010, this option is called Clip Art.) 

 
Adding text to a slide  
 

 Please click on the Title, Subtitle, or Text placeholder. 

 Type the text as you want. 

 If necessary, press [Return] or [Enter] to move to a new line. 

 Click anywhere on the slide outside of the placeholder to deselect it. 
 
Q16. What is the difference between Machine Language and High Level 
Language? 
 
Ans:- Machine Language:  
A computer programming language consisting of binary instructions which a computer 
can respond to directly. 
Sometimes it is referred to as machine code or object code, machine language is a 
collection of binary digits or bits that the computer reads and interprets. A computer 
cannot directly understand the programming languages used to create computer 
programs, so the program code must be compiled. Example: 01001000, 01100101, 
01101100, 01101100 etc 
 



 High - level language:  A high-level language is any programming language that 
enables development of a program in a much more user-friendly programming context. 
 
This language is a programming language with strong abstraction about the details of 
the computer in contrast to low-level programming language (Assembly Language). 
Ex: C, C++, Java 
 
High level languages are grouped in two categories based on execution model – 
compiled or interpreted languages. Compiler and interpreter are used to convert the 
high level language into machine level language. The program written in high level 
language is known as source program and the corresponding machine level language 
program is called as object program. Both compiler and interpreter perform the same 
task but there working is different. Compiler read the program at-a-time and searches 
the error and lists them. If the program is error free then it is converted into object 
program. When program size is large then compiler is preferred. Whereas          
interpreter read only one line of the source code and convert it to object code. 
 
 
Q17. Discuss about different data types of C programming Language. 
 
Ans:- DATA TYPES 
Let's discuss about a very simple but very important concept available in almost all the 
programming   languages which is called data types. As its name indicates, a data type 
represents   a type of the data which you can process using your computer program. It 
can be numeric, alphanumeric, decimal, etc. 
 
Let‘s keep Computer Programming aside for a while and take an easy example of 
adding two whole numbers 10 & 20, which can be done simply as follows – 
 
100 + 200 
 
Let's take another problem where we want to add two decimal numbers 100.50 & 
200.50, which will be written as follows – 
 
100.50 + 200.50 
 
The two examples are straight forward. Now let's take another example where we want 
to record student information in a notebook. Here we would like to record the 
information like Name, Class, Section: A and Age 
 
Now, let's put one student record as per the given requirement – 
 
Name: Ram Kumar 
Class: 12th 
Section: A 
Age: 25 
 
The first example dealt with whole numbers, the second example added two decimal 
numbers, whereas the third example is dealing with a mix of different data. Let's put it 
as follows – 
 

 Student name "Ram Kumar" is a sequence of characters which is also called a 
string. 



 Student class "12th" has been represented by a mix of whole number and a 
string of two characters. Such a mix is called alphanumeric. 

 Student section has been represented by a single character which is 'A'. 

 Student age has been represented by a whole number which is 25. 
 
This way, we realized that in our day-to-day life, we deal with different types of data 
such as strings, characters, whole numbers (integers), and decimal numbers (floating 
point numbers). 
 
Similarly, when we write a computer program to process different types of data, we 
need to specify its type clearly; otherwise the computer does not understand how 
different operations can be performed on that given data. 
 
Different programming languages use different keywords to specify different data types. 
For example, C and Java programming languages use int to specify integer data, 
whereas char specifies a character data type 
. 
C and Java Data Types 
C and Java support almost the same set of data types, though Java supports additional 
data types. For now, we are taking a few common data types supported by both the  
 
These data types are called primitive data types and you can use these data types to 
build more complex data types, which are called user-defined data type, for example a 
string will be a sequence of characters. 
 
Python Data Types 
Python has five standard data types but this programming language does not make use 
of any keyword to specify a particular data type, rather Python is intelligent enough to 
understand a given data type automatically, like - number, string etc. Here, Number 
specifies all types of numbers including decimal numbers and string represents a 
sequence of characters with a lengthof 1 or more characters. 
 
 
Q19. Describe the syntax of the following statements  
 
a) If – else statement         b) for loop        c) while loop       d) do-while loop  
 
Ans:- 
IF … else satatement: if statement can be followed by an optional else statement, 
which executes when the Boolean expression is false. The syntax of an if...else 
statement in C programming language is − 
if (expression) 
{ 
Block of statements; 
} 
else 
{ 
Block of statements; 
} 
The above syntax can be represented in the form of a flow diagram as shown below – 



                                          
for loop 
for loop is similar to while, it's just written differently. for statements are often used to 
process lists such a range of numbers: 
Basic syntax of for loop is as follows: 

 

for( expression1; expression2; expression3) 
{ 
Single statement 
or 
Block of statements; 
}  
In the above syntax: 

 expression1 - Initializes variables. 

 expression2 - Conditional expression, as long as this condition is true, loop will 
keep 

 executing. 

 expression3 - expression3 is the modifier which may be simple increment of a 
variable. 

 
while loop 
The most basic loop in C is the while loop. A while statement is like a repeating if 
statement. Like an If statement, if the test condition is true: the statements get executed. 
The difference is that after the statements have been executed, the test condition is 
checked again. If it is still true the statements get executed again. This cycle repeats 
until the test condition evaluates to false. 
 
Basic syntax of while loop is as follows: 
 

while ( expression ) 
{ 
Single statement 
or 
Block of statements; 
} 
The above code can be represented in the form of a flow diagram as shown below – 

                                             



 
do...while loop 
do ... while is just like a while loop except that the test condition is checked at the end 
of the loop rather than the start. This has the effect that the content of the loop are 
always executed at least once. 
 
Basic syntax of do...while loop is as follows: 

do 
{ 
Single statement 
or 
Block of statements; 
}while(expression); 
 
The above code can be represented in the form of a flow diagram as shown below – 
                       

                           
 

 
Q20. Find the output of the following program segments 

 
a)  b)  c)  
#include <stdio.h>  
int main()  
{  
int i;  
for (i=1; i<2; i++)  
{  
printf( "IMS Ghaziabad\n");  
}  
}  

#include <stdio.h>  
int main()  
{  
int i = 1;  
while ( i <= 2 )  
{  
printf( "IMS Ghaziabad\n");  
i = i + 1;  
}  
}  

#include <stdio.h>  
void main()  
{  
int a = 10, b=100;  
if( a > b )  
printf( "Largest number is %d\n”, 
a);  
else  
printf( "Largest number is %d\n”, 
b);   

 
Ans:-  
 

a] 
 

b] 
 

c] 
 

Output Output Output 

Hello 0 
Hello 1 
Hello 2 
Hello 3 
Hello 4 

             Hello 0 
Hello 1 
Hello 2 
Hello 3 
Hello 4 

             Hello 0 
Hello 1 
Hello 2 
Hello 3 
Hello 4 

 


